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Pro Tools and Pro Tools | HD Software 12.4 on Windows 7 
and Windows 8.1

This Read Me documents important compatibility information and known issues for Pro Tools® and Pro Tools | HD Software 12.4 on 
Windows 7 (64-bit) and Windows 8.1 (64-bit).

Compatibility
Avid can only assure compatibility and provide support for qualified hardware and software configurations. 

EuControl version 3.3 required for use with Pro Tools 11.3 and higher
Pro Tools 11.3 and higher require EuControl software version 3.3 or higher to enable use of EUCON-enabled devices. 
Update to EuControl software 3.3 or higher before launching Pro Tools 11.3 or higher. 

iLok USB Smart Key (2nd Generation) and Pro Tools Authorization

An iLok (2nd Generation) must be connected at all times while running Pro Tools

Pro Tools requires that an iLok (2nd Generation) with the appropriate authorizations be connected to the computer at all times. Do not 
remove the iLok while running Pro Tools. If the iLok is removed while Pro Tools is running, one of the following will occur:

Pro Tools displays a dialog giving you the following choices:

• Reinsert the iLok and click Save. Pro Tools saves the session and then quits.

• Click Quit. Pro Tools closes the session without saving and then quits. 

– or –

Pro Tools displays a dialog giving you the following choices:

• Reinsert the iLok and click OK to continue working in Pro Tools.

• Click Cancel. Pro Tools closes the session without saving and then quits.

Pro Tools does not recognize iLok connected to USB3 ports (PTSW-158204)

Texas Instruments USB3 controllers are currently incompatible with iLok generation 1 & 2 USB keys. iLok keys connected to a Texas 
Instruments USB3 controller will not be recognized by Pro Tools or the ilok.com website. Connect any iLoks to USB2 ports instead. 

Avid Application Manager

Use the Avid Application Manager for notifications about Pro Tools software and plug-in updates

When you install Pro Tools 12.x, the Avid Application Manager is also installed. The Avid Application Manager is used to manage your 
software and entitlements related to your MyAvid account. The Avid Application Manager helps you maintain the most current 
Pro Tools software and audio plug-in updates that you are entitled to when new versions become available. For more information about 
the Avid Application Manager, see the Avid Application Manager Guide (available online through the Avid Knowledgebase).

For the latest compatibility information—including qualified computers, operating systems, and third-party products—visit the 
Avid website (www.avid.com/compatibility).
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Pro Tools 12 Installation

On Windows 7, Pro Tools 10.3.10 can be co-installed on the same system with Pro Tools 12.0. (Windows 7 Only)

If you have an earlier version of Pro Tools installed, it is recommended that you perform a clean uninstall before installing Pro Tools 
10.3.10 (or higher) and Pro Tools 12.0 (or higher). Installing Pro Tools 12.0 will overwrite Pro Tools 11.x if it is already installed.

Uninstalling Pro Tools does not uninstall all components that are installed with Pro Tools. (PT-202003)

When you uninstall Pro Tools using the Programs and Features Control Panel, some components that are installed with Pro Tools are 
not uninstalled (such as Avid Effects, Avid Application Manager, and Avid Application Manger Helper). Use the Programs and Fea-
tures Control Panel to uninstall these components separately.

General Compatibility

Pro Tools 12 does not support video capture (PTSW-181456)

Pro Tools 12 does not have the ability to record video to the timeline. Co-install Pro Tools 10.3.10 (or higher) on the same system and 
use an Avid Mojo SDI to record video into Pro Tools 10. The captured video can then be used in Pro Tools 12. 

Pro Tools 12 does not allow import of WMA files (PTSW-181506)

If you attempt to import a WMA file into a Pro Tools 12 session, Pro Tools cannot convert the file and posts a “file is unreadable”
message. Co-install Pro Tools 10.3.10 (or higher) on the same system, import the WMA file, and convert it to a format supported by 
Pro Tools 12. 

Pro Tools 12 sessions that use more than 4 gigabytes of RAM will cause Pro Tools 10 or lower to quit unexpectedly 
(PTSW-181963)

If you attempt to open a Pro Tools 12 session that uses more than 4 gigabytes of RAM in Pro Tools 10 or lower, Pro Tools will quit un-
expectedly. To open such sessions in Pro Tools 10 or lower, first reduce the amount of session RAM usage to less than 4 gigabytes in 
Pro Tools 12 by removing virtual instruments that take up system memory. 

OMF files that contain video are not compatible with Pro Tools 12 (PTSW-184397)

OMF sequences that contain video cannot be imported into Pro Tools 12. OMF sequences that contain embedded or referenced audio 
files can be imported into Pro Tools 12. To import a sequence that contains video media, use a linked AAF sequence.

Pro Tools session file formats version 4.x and lower are not supported in Pro Tools 11 and higher (PTSW-181049)

Pro Tools session files from Pro Tools versions 4.x and lower are not recognized in Pro Tools 11 and higher. In the Pro Tools Work-
space, these files are listed as “unknown,” and cannot be opened. Co-install Pro Tools 10.3.6 (or higher) on the same system and open 
the session files in Pro Tools 10. Save the session in the current Pro Tools session format, then open the session in Pro Tools 12.

Automatic Update Notification will not connect through a proxy server that requires authentication (108837)

Software Updater will not find an active Internet connection when behind a proxy server that requires authentication to gain Internet ac-
cess. To work around this, the client machine with Software Updater needs to be moved out from behind the proxy, or the proxy needs 
to allow HTTP access via port 80 without requiring authentication.

Aero causes errors at lower HW Buffer sizes (103563)

With Aero enabled in Windows, Pro Tools will not play back without errors at HW Buffer sizes of 128 and below. Turn off Aero if you 
want to use lower HW Buffer sizes.

Eleven Rack

Eleven® Rack Guitar Window not available in Pro Tools 12 (PTSW-184398)

Pro Tools 12 does not provide the Guitar Window for Eleven Rack that is available in lower versions of Pro Tools. Avid has made avail-
able a 64-bit standalone version of the Eleven Rack Control Window found in Pro Tools 10 and earlier. Please see the following page 
for more information about the 64-bit standalone Eleven Rack Editor: http://apps.avid.com/eleven-rack/
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VENUE
VENUE systems with two HDx Option cards may not be recognized by Pro Tools | HD Native systems (PTSW-142834)

If a second HDx Option card is installed in a VENUE system, it may cause both HDx cards not to be recognized by HD Native systems. 
A single VENUE HDx Option card is recognized properly by HD Native systems, so for consistent performance it may be necessary to 
de-install the second VENUE HDx Option card.

Known Issues 
The following sections document known issues you may encounter when using Pro Tools and Pro Tools HD 12.4, along with 
workarounds if they exist.

General Pro Tools Issues

Pro Tools is slow to launch and may become unresponsive if a CD or DVD is mounted by your system. (PT-201624)

If a CD or DVD is mounted by your system, Pro Tools takes an exceptionally long time to launch. Additionally, Pro Tools may become 
unresponsive while a CD or DVD is mounted by your system. To resolve this issue, exit Pro Tools, eject the disc, and then relaunch 
Pro Tools.

Error messages are displayed while unzipping the downloaded Pro Tools installer zip file (PTSW-181403)

While unzipping the downloaded Pro Tools installer .zip file, errors are displayed saying that certain files are missing. If you proceed 
and run the unzipped installer, then these files will be reported missing. To avoid this issue, move the downloaded .zip file to the root 
(top most) directory of a volume first (such as the C: drive), and then unzip.

Clicking on a Pro Tools window that may be visible will not always bring Pro Tools to the foreground, especially if a process 
is running in Pro Tools (such as Bounce to Disk)

If Pro Tools is not the foreground application, you can bring it to the foreground by doing one of the following:

 Click the Pro Tools icon in the Windows Taskbar.

 Press the Start+Tab keys to bring the Pro Tools application to the front.

Pro Tools does not launch (58531)

Pro Tools will not launch if hardware drivers are not installed or if there are no Inputs or Outputs set in the Control Panel for your audio 
interface. If Pro Tools does not launch, be sure the drivers for your audio interface were installed before Pro Tools installation. For M-
Audio and some third-party interfaces, if the drivers are already installed, go to the Control Panel for your audio interface and make sure 
either the Analog or S/PDIF Inputs and Outputs are enabled.

Pro Tools quits unexpectedly when manually moving clips with sections out of the session length bounds (PTSW-188679)

Clips that are moved outside of the session bounds may cause Pro Tools to quit unexpectedly. To avoid this, adjust the Session Length 
setting (in the Session Setup window) to ensure that there is sufficient time for all material in the session.

Session templates retain I/O settings and some preferences, display settings, and window layouts (PTSW-47133)

Pro Tools session templates retain the I/O settings and some of the preferences, display settings, and window layouts from the system 
on which the template was created. Consequently, new sessions based on a template restores several session properties from the original 
system. These properties are retained by Pro Tools until you change them or another session or template is opened that replaces them. 
This also means that if a new blank session is created after using a template, the properties from the template will be used for the new 
session.

The properties retained from templates include default track height, view settings, window size and position, and I/O Setup. You can up-
date templates by making the desired changes, using the File > Save as Template command (be sure to select the “Install template in sys-
tem” option), and then selecting the template you want to replace.
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Trying to load a session from an unmapped network drive results in the error: “Pro Tools application has stopped working” 
(PTSW-125913)

When trying to load a session from an unmapped network drive, the error “Pro Tools Application has stopped working” will occur. To 
avoid this problem, be sure to map the network drive to a drive letter, set up the drive as transfer volume, and then open the session.

Pro Tools does not play back immediately after importing a large and complex AAF sequence (UME-905)

Importing a complex AAF sequence that contains many video files and edits may cause Pro Tools to be in a Play/Pause state after all 
files have finished linking. This may also happen when reopening the session. If you encounter this, stop the transport, wait 30 seconds, 
and then attempt playback again. To avoid this problem completely, you can bounce the video and re-import, or request that the video 
editor flatten the video upon export.

Offline Bounce takes much longer than expected (PT-202888)

Offline Bounce times can increase significantly in sessions that have output and input assignments cascaded across tracks (for example: 
Track 1 output is assigned to Track 2 input, Track 2 output is assigned to Track 3 input, and so on).

Windows 7 Systems do not support double-clicking to launch Pro Tools session or installer on external FireWire HFS+ drive 
(PTSW-35457)

On Windows 7 systems, if the session or installer is located on an external FireWire HFS+ drive, you cannot double-click on it to launch 
the session or installer. To launch a Pro Tools session located on an HFS+ drive, launch Pro Tools first, and then use the Open Session 
command in the File menu to open your session. For Pro Tools installation, copy the installer onto an internal drive, and run the installer 
from there.

Windows erroneously reports that Pro Tools has stopped responding

Clicking on the splash screen while Pro Tools is launching can result in a Windows error stating that Pro Tools has stopped responding. 
Pro Tools is actually still loading normally and will finish launching if you just don’t do anything or if you click “Wait for the Program 
to Respond.”

Automation is replaced instead of overlaid when using Adjust Session Start Time to Match Source Start Time when importing 
session data (PTSW-149273)

Automation can sometimes be replaced instead of overlaid when using Adjust Session Start Time to Match Source Start Time when im-
porting session data. This issue may occur if the source session start time (of the session being imported) is earlier than the current ses-
sion start time. This issue can be avoided if you instead import the session data from the session with the later start time into the session 
with the earlier start time. You must also not enable the Adjust Session Start Time to Match Source Start Time option, and select Main-
tain Absolute when prompted.

Start+L launches the Switch Admin User prompt instead of nudging cursor to the left (PTSW-17100)

Start+L Key launches the Switch Admin User prompt instead of nudging the cursor to the left. As a workaround, enable Keyboard Focus 
(A...Z) and use the L key.

Scrubbing audio is offset by the overall system delay when Automatic Delay Compensation is enabled (PTSW-150138)

With Automation Delay Compensation enabled, when scrubbing audio the output is offset by the overall system delay (displayed in the 
Session Setup Window). Large system delays cause a noticeable offset. To avoid this issue, you can disable Automatic Delay Compen-
sation when you want to scrub audio for editing.

Audio clips on tick-based tracks do not play at the correct tempo after opening a Reason song with a different tempo 
(PTSW-34086)

Audio clips on tick-based tracks do not play at the correct tempo after opening a Reason song with a tempo that is different from the one 
in your session. To correct this, make any tempo change via the Conductor track or the Manual Tempo input and the clips will play back 
correctly.
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Cannot run Reason or Record as ReWire clients if they have not first been launched and set up as a standalone application 
(PTSW-133070)

Reason and Record need to be launched and setup as a stand-alone applications before running them as a ReWire clients with Pro Tools. 
Do the following:

• Launch Reason or Record in stand-alone mode and follow the on-screen instructions.

• Quit Reason or Record.

• Launch Pro Tools and insert Reason or Record as a ReWire plug-in on an audio, Auxiliary Input, or Instrument track.

Cannot drag and drop media files from the Desktop to Pro Tools (Windows 8 Only) (PTSW-181311)

If UAC is enabled on Windows 8, dragging and dropping media files from the Desktop is disallowed. To avoid this issue, disable UAC.

When importing audio from a network share, “file is unreadable” or other errors occur (PTSW-149570)

When importing an audio file from a network share using the Import Audio dialog or a direct shortcut to the share, Pro Tools may dis-
play an error such as “The audio file is unreadable by Pro Tools” or “The mp3 cannot be imported because QuickTime is not installed,” 
even though QuickTime is installed on the system. If this occurs, map a drive letter to the network share and use the drive letter in the 
Import Audio dialog to navigate to the audio file. 

Importing MP3 or MP4 files without QuickTime installed (PTSW-61863)

If Pro Tools has been run on a system on which QuickTime was not present, but then QuickTime is installed later, there is the possibility 
that Pro Tools has indexed QuickTime files as “Unknown.” These files will remain as unknown even after QuickTime has been in-
stalled. If this occurs, either delete DigiBase Database files and try again, or navigate in the browser to any “Unknown” QT file and se-
lect “Update Database for Selected.”

Conversely, if Pro Tools has been run on a system with QuickTime present, but then QuickTime is uninstalled, there is the possibility 
that QuickTime files have been indexed as known audio file types that can no longer be understood by Pro Tools since QuickTime is 
now absent. If this occurs, delete all database files and try again.

Issues with Kensington mouse and drivers

The following may occur when using a Kensington mouse with Pro Tools: 

• Alt key sticks when Zooming (61823) 

• Stuck Shift Key (62376)

• Stuck Control Key (61830, 62066, 61980, 61988, 62348, and 62559). 

To clear stuck keys, press them again. If problems continue, try removing the Kensington drivers. 

Error message “Could Not Complete Your Request because the System Cannot Find the File Specified (2)”
(# 50454 and # 50457)

This message can appear while logged into a non-administrative account and doing either of the following: 

• Performing destructive AudioSuite processing

• Locking files in the Workspace browser 

This is possibly because the audio file has read-only permissions. In order to correct this, you must be able to log into an administrative 
account in Windows and change the permissions of the audio file so you have full read and write access to the audio file. If you do not 
have administrative access of the computer, then you must either contact the administrator of the computer to resolve this problem, or 
use the File > Save Copy In command to create a copy of the session with all of its audio files.

Groove Templates (43997)

Pro Tools will be unable to retrieve custom Groove Templates that are saved in an incorrect directory. Groove Templates should be 
saved only within the “Grooves” folder.
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Clip Groups can be dragged to tracks in Playlist view even though Clip Groups are not supported in Playlist view 
(PTSW-152707)

It is possible to drag a clip group to a track in Playlist view even though clip groups are not supported in Playlist view. Normally, when 
switching to Playlist view from another track view, any clip groups on that track are automatically ungrouped. While clip groups 
dragged to tracks in Playlist view may appear to work properly, it is recommended that you ungroup them while in Playlist view to en-
sure proper behavior.

Importing tracks with Import Session Data clears the Undo queue (51775)

It is documented in the Pro Tools Reference Guide that importing tracks through Import Session Data clears the Undo queue. More spe-
cifically, the Undo queue gets cleared when Main Playlist Option is set to “Import - Replace existing playlists.” The Undo queue does 
not get cleared if the option is set to “Import - Overlay new on existing playlists” or “Do Not Import.”

Unrendered mix and match AAFs will not properly import (PTSW-181825)

If the error “A video file and its associated clips were removed because its timecode rate is incompatible with the project type” appears, 
it is likely that your AAF contains unrendered mix and match video. To avoid this, render mix and match AAFs from Media Composer 
before or during export.

AAF files that contain AMA-linked audio cannot be imported (PTSW-182322)

Pro Tools cannot import AAF files that contain AMA-linked audio files. AMA-linked audio must be imported or transcoded in 
Media Composer before the AAF is exported.

With the Pro Tools Web browser, links to external sites do not work as expected (PTSW-145325)

In the Pro Tools Web browser, navigating to external sites using links from Avid web pages (such as links to social networks like Face-
book and LinkedIn) may not work as expected. For the sake of security, the Pro Tools Web browser is restricted to avid.com pages. If 
you want to browse sites other than avid.com, or share avid.com pages with friends, use the Launch Page in External Browser feature 
to view the page in your default Web browser and navigate from there.

Clip names appear incorrect after selecting Field Recorder channel matches, or expanding to new tracks. (PTSW-136012)

This can occur if the file name of a Field Recorder channel match contains a hyphen followed by a number greater than zero. Pro Tools 
names new clips by incrementing the number after the hyphen. If a field recorder file is already named in this way (such as “Filename-
01”), then new clips created by selecting a Field Recorder channel match or by expanding a track may have names different from the 
parent file. To avoid this situation, avoid using hyphens in Field Recorder file names.

Field Recorder matches appear offset after AudioSuite rendering if the session timecode rate does not match the file timecode 
rate (PTSW-152147)

If a portion of a file has been rendered with an AudioSuite plug-in, an offset can occur when expanding field recorder matches in cases 
where the session timecode rate does not match the timecode rate of the audio file. To avoid this issue, you can either render the whole 
file with AudioSuite (rather than only a portion of the file), or use Whole File mode when rendering AudioSuite processing.

External Field Recorder matches do not show up after an initial index pass (PTSW-180659)

If external field recorder matches do not show up on a field recorder track after the initial index pass, save and reopen the session.

Avid Application Manager

Canceling the installation of Application Manager 2.3 patch (upgrade) corrupts dependent components (Windows Only) 
(RELENG-1238)

On Windows, if you cancel the installation of Application Manager 2.3, dependent components may be corrupted. To correct this prob-
lem, do one of the following:

• Reinstall the application that was installed along with Application Manager (such as Pro Tools or Media Composer).

• Log in to your MyAvid account, and download and install Application Manager 2.3 (or higher) from the Avid Download Center.
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I/O Setup

I/O Setup files can be saved with illegal characters when Enforce Mac/PC Compatibility option is not enabled (60730)

When importing I/O Setup files (.pio files) from Mac sessions that were not saved with the Enable Mac/PC Compatibility option en-
abled, files that have illegal characters are not converted successfully—illegal characters do not get replaced with an underscore.

Master Faders assigned to mapped output busses function only on that specific bus, not for the output channel as a whole 
(PTSW-127517)

Because a Master Fader works on a bus, not on an output path or output channel, there may be certain configurations in which the level 
sent to the physical I/O is not reflected on any meters in the Pro Tools application. If the configuration includes output subpaths or has 
multiple busses assigned to a single output path, the overall signal level from these combined sources (including any clipping indication) 
will only be displayed on the interface itself. You can avoid using multiple output paths or output busses simultaneously by routing your 
sources to a single mapped output bus and assign a Master Fader to that.

Opening a session saved to .ptf (Pro Tools 7–9) from Pro Tools 12.x or higher in Pro Tools 8.1 or lower results in incorrectly 
mapped IO (PTSW-194443)

For any session saved to .ptf (Pro Tools 7–9) from Pro Tools 12.x or higher requires that IO Settings be manually corrected when open-
ing that session with Pro Tools versions 8.1 and lower. Manually map the correct IO settings in the IO Setup before playing back the 
session.

File and Disk Management

Auto-saving with external hard drives that have little free space can result in data loss (PTSW-32639)

When recording to hard drives that do not have much free space available and when the Auto-Save preference is turned on, it is possible 
to completely fill your record drives, and cause data loss. While this occurrence is rare, it can also result in external drives that will fall 
offline and not be able to used on the Windows system. It is recommend that you do not allow your record drives to become completely 
full, and that you manually back up your projects on a regular basis.

Pro Tools unable to relink to audio files and fade files that have illegal characters when Enforce Mac/PC Compatibility is not 
enabled (PTSW-57355)

A Pro Tools session is unable to relink to audio files and fades that have illegal characters if the session was copied without the Enable 
Mac/PC Compatibility option enabled. The workaround is to open the DigiBase Project Browser and manually relink each file by 
Unique ID.

Importing interleaved BWF files exported from Pro Tools 10 and higher into Pro Tools 9.0.x (and lower) may cause Pro Tools 
to quit unexpectedly (PTSW-151579)

When exporting any greater-than-stereo multichannel interleaved WAV (BWF) files other than 5.1 from Pro Tools 10 and higher, and 
then importing them into Pro Tools 9.x or lower, Pro Tools quits unexpectedly. To avoid this problem, export audio files for import into 
lower versions of Pro Tools in another file format (such as AIFF or multi-mono).

Unable to open Mac sessions from Workspace if illegal characters in session name were converted to underscore symbols 
(PTSW-52463)

You will not be able to open a Mac session from the Workspace if the session name contains illegal characters that were converted to 
underscores. The workaround is to open the session using the File > Open command.

Multiple files with the same name do not relink properly when Save Copy In command is used with Preserve Folder Hierarchy 
option (PTSW-28069)

When saving a session copy with Preserve Folder Hierarchy checked, files with the same name may not relink properly when using 
Manual Relink. When opening the session copy, use Automatically Relink to locate the correct files. If the session has already been 
opened using Manual Relink and some files are still offline, select Relink Offline in the Project Browser to manually relink the remain-
ing files.
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Missing files when opening a session created by a lower version of Pro Tools (37572)

When opening some sessions created by a lower version of Pro Tools, some files may be missing. You should be able to relink these 
files in the Relink window by Name and Duration. In some cases Match Format may not result in found links.

After Relinking files the Relink window does not retain its “revealed/open” status (PTSW-178130)

Although the checkbox remains selected, the reveal status of volumes is not retained if the Relink window is automatically reopened. 
Be sure to reveal the volumes so that the enabled checkboxes are visible in order to reliably relink to missing files. 

“Access Violation” on playback of read-only sessions

Pressing play in a session recently restored from CD-ROM may result in a dialog stating “Access Violation.” This happens if the session 
(and its audio files) are marked with the Read-Only flag. If you do not know how to remove the Read-Only flag from your files, please 
consult Windows Help.

Unable to create a session when navigating through the Windows 7 Libraries directory (PTSW-133266)

When creating a session in Pro Tools, if you navigate to the location where you want to save the session through the Windows 7 Librar-
ies directory path, you will be unable to create the session. To avoid this problem, navigate to the location where you want to save the 
session through another directory path, such as Drive:\Users\User Name\My Documents\... .

When relinking audio files, mismatched channel widths are not found (PTSW-189868)

When relinking audio files, it is possible to link files with different channel widths. This is not a supported workflow and may have un-
predictable results. Ensure that the channel width of linked files match the channel widths of clips in the session to avoid this issue. 

Elastic Audio

Maintaining phase coherency with Elastic Audio pitch processing (PTSW-20602)

When there is Elastic Audio Pitch processing enabled on a track, switching from Polyphonic, Rhythmic, or X-Form to Monophonic or 
Varispeed can disrupt phase coherency. To preserve phase coherency in this case, be sure to clear all Elastic Audio Pitch processing 
from the track before switching to the Monophonic or Varispeed algorithm.

Drift in an audio file may occur when using Elastic Audio and the Monophonic or X-Form algorithms (PTSW-33768)

Drift in an audio clip may occur when using elastic audio depending on how much the clips is expanded or compressed when using the 
Monophonic algorithm. If you are using elastic audio with material that contains transient information in it that you would like to keep 
from drifting, you should use the Polyphonic or Rhythmic algorithms.

Displayed timebase is incorrect after importing Elastic Audio tracks (PTSW-46897)

The incorrect timebase is displayed after importing Elastic Audio tracks to existing tracks with opposite timebase. You will need to man-
ually select the correct timebase for the affected tracks.

Elastic Audio clips on Playlist lanes are not rendered (PTSW-47311)

In Playlists View, any Elastic Audio clips on Playlist lanes are not rendered (waveform is “off-line”) when changing the track’s Elastic 
Audio processing from Real-Time to Rendered. Using the object grabber to select any off-line clips, promoting them to the main playlist 
or copying and pasting the clips in place will render using the selected Elastic Audio algorithm.

Cannot import Elastic Audio tracks with the Consolidate From Source Media option (PTSW-33894)

Use Copy from Source Media to import Elastic Audio tracks. 
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Track Commit and Track Freeze

Frozen Tracks are opened in a partially frozen state in certain versions of Pro Tools 12 (PT-208260)

Opening sessions created in Pro Tools 12.4 that have frozen tracks in Pro Tools 12.0 to 12.2.1 will result in graphical issues for "frozen" 
clips (such as waveforms overlaying clip boundaries, missing clip boundaries, or clip boundaries that move without waveforms), tracks 
and inserts (inserts can be in an inactive/frozen state and cannot be activated). In versions of Pro Tools 11.3.2 and earlier, or Pro Tools 
12.3, these problems do not occur and the track is opened in it's unfrozen state.

Relinking to missing rendered “frozen” Auxiliary Input tracks does not yield any results when reopening a session (PT-210026)

If there is missing rendered audio from frozen Auxiliary Input tracks, they cannot be relinked  after first time of reopening a session. 
Task Manager will report: “Some Files to relink Not Found.” To correct this issue, close and reopen the session, and try to relink to the 
missing files again.

Frozen tracks are not translated by AAF and Interplay unless committed (PT-210128)

Only the unprocessed source audio on frozen tracks is translated by AAF and Interplay To ensure that the desired track audio processing 
is translated accurately for AAF sequences (and Avid Interplay), commit those tracks rather than freeze them.

HEAT continues to process frozen tracks if HEAT is globally deactivated (PT-210184)

If one or more tracks are frozen while being processed by HEAT, HEAT continues to process those tracks even when deactivated (Op-
tions > Activate HEAT). In this case, once HEAT is deactivated, unfreezing and refreezing any tracks applies HEAT twice. HEAT con-
tinues on these tracks until HEAT is globally reactivated and the tracks are unfrozen.To avoid this issue, bypass HEAT rather than de-
activating it.

Clip names on Committed Tracks may inherit names from clips on tracks feeding Plug-in Multi-Output or Side-Chain Input paths 
(PT-207305)

In some cases clip names on committed tracks may be taken incorrectly from other tracks in the session. This may occur in some cases 
when a track that is being committed is receiving an auxiliary output stem from a plug-in or contains a plug-in receiving side-chain input 
from an internal bus.

Committing clips on Instrument tracks by dragging them to audio tracks with the Downmixer plug-in may render an incomplete 
clip. (PT-207317)

Committing MIDI clips on Instrument tracks by dragging them to audio tracks with Downmixer may render an incomplete clip. Using 
the Grabber tool on these incomplete clips may not function over the incomplete areas of the clip. To avoid this issue, Commit Instru-
ment track clips to new Audio tracks before inserting the Downmixer plug-in.

When committing from two or more Instrument tracks in a session with tempo changes by dragging and dropping to audio 
tracks, and where the Instrument tracks include a mix of sample-based and tick-based tracks, the tick based committed clip is 
trimmed to matched the source MIDI original duration even though the audio committed from tick-based MIDI follows the tempo 
changes. (PT-208300)

To avoid this issue, use the Trim tool to reveal the rest of the committed audio or commit sample-based MIDI clips and tick-based clips 
separately.

MIDI

Versions of Sibelius lower than 7.5 do not launch when using the Send to Sibelius command (PTSW-24193, SIB-164)

When you first install any of the supported Sibelius packages (Sibelius, Sibelius First, or Sibelius Student), the Send to Sibelius com-
mand in Pro Tools will return a false error stating that Sibelius is not installed in the system. To avoid this problem, launch Sibelius man-
ually and create a score document. This will only needs to be done once, after which the Send to Sibelius command should function 
properly.
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When using Import Session Data on a MIDI track with Real-Time Properties enabled and set to using diatonic transposition, 
transposition is based on the first key signature in the session only (PTSW-49297)

When importing session data from a session that includes multiple key signatures and a MIDI or Instrument track with the “Transpose 
in Key” Real-Time property enabled, the transposition will be based only on the first key in the session. This can be corrected by tog-
gling the Real-Time Properties off and on, at which point the diatonic transposition will be correct for each key.

Unavailable MIDI input paths for MIDI and Instrument tracks are not indicated (PTSW-46839)

The device or path name for MIDI Input on MIDI and Instrument tracks is not italicized and grayed out when opening a session on a 
system where the device or path are not actually present.

Clip outlines do not resize when moving or copying tick-based midi clips across tempo changes (PT-208692)

Clip outlines do not resize when moving or copying tick-based midi clips across tempo changes. Additionally, if View > Clip > Trans-

parency is enabled, MIDI notes are misaligned with clip boundaries.

Plug-Ins

Purchasing and installing a newer version of an already installed plug-in may cause a system restart (PT-201687)

If you use the In-Application Plug-in Marketplace to purchase and install a plug-in that is already installed on your system, your com-
puter may restart during installation. This only occurs if the currently installed version is older than the version you just purchased and 
downloaded. If you want to buy an additional license for a plug-in you already own please do so at https://shop.avid.com. If you want 
to install the latest version of a plug-in that you already own, please visit https://account.avid.com/subscriptions or 
https://www.avid.com/plugins; find the version of the plug-in you want, and then download and install it.

AudioSuite and Clip Groups (PTSW-57457)

AudioSuite plug-ins handle Clip Groups in the Clip List slightly differently than audio files. With audio files, an AudioSuite process can 
be applied to all copies of a unique audio file which appear in your session by selecting your target as Clip List in the AudioSuite plug-
in window and selecting Use in Playlist. However, if your target is set to Clip List in the AudioSuite plug-in window while you have a 
Clip Group selected, Pro Tools does not recognize the Clip Group as processable audio and will present a No Audio was Selected error. 
This is because a clip group is not treated as audio until it is actually used in a track.

To apply an AudioSuite process to all copies of a Clip Group in a session at once, do the following:

1 Select the Clip Group to be processed.

2 From the Clip List menu, select Ungroup All. All elements of the group will remain selected.

3 Perform AudioSuite processing.

4 From the Clip List menu, select Regroup.

5 When prompted, select Modify to apply the AudioSuite Process to all copies of the Clip Group in the session, or Copy to apply it only 
to the selected Clip Group.

Plug-In Find and Relink with file types not supported by Pro Tools (111704)

Find and Relink will not be triggered by plug-ins in situations where plug-ins are missing links to file types that are not natively sup-
ported by Pro Tools (such as REX files). To have full Plug-in Find and Relink support, the file types used by plug-ins must also be sup-
ported by Pro Tools.

MIDI outputs to some software synthesizer plug-ins are italicized in cross-platform sessions (PTSW-33965)

With some software synthesizers, MIDI output ports show up italicized when opening a session on a different computer platform than 
the session was created on until you re-assign the outputs.

For known issues about specific plug-ins, see the Audio Plug-ins Read Me.
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When replacing one plug-in with another, the new plug-in inherits previously auto-enabled parameters. (PT-202826)

With the Plug-in Controls Default to Auto-Enabled preference enabled, all available automation parameters become unexpectedly re-en-
abled (merged) after replacing one instance of the plug-in with another. Disable this preference before replacing one plug-in with an-
other to avoid this issue.

HDX Systems

Pro Tools does not play back when an invalid sync source is selected on SYNC HD (Word Clock or AES/EBU) (PTSW-156651)

When attempting to initiate playback, playback will fail if a SYNC HD is connected to an HDX card and an Avid audio interface with 
no connections to either the word clock or AES/EBU ports. Ensure that the clock is set to a working clock source to resolve this issue.

In Avid DigiTest, the reported slot number may not correspond to the physical slot number in the computer (PTSW-155373)

In Avid DigiTest, the slot number reported for HDX cards starts from 0 on up. For example, “Slot 1” does not necessarily correlate to 
the first physical slot in the machine. If you have an HDX card that is having problems, match the Serial Number ID on the back of the 
card with the Serial Number ID displayed on the Slot Info page in Avid DigiTest.

Audio stops in certain circumstances with multi-card HDX systems (PTSW-158701 and PTSW-157600)

Signal routing issues are known to occur with HDX systems on HP Z800 Workstations. To resolve these issues, run HP Performance 
Advisor software after installing Pro Tools, and load the Avid optimized settings.

Corrupted audio when bus recording or bouncing to disk (PTSW-158063 and PT-202030)

HP Z800 workstations can drop samples while recording or bouncing to disk when an HDX card is present in PCIe Slot #3 (connected 
to the Southbridge). This problem is resolved by updating the HP Z800 to the latest BIOS (3.54) or by installing the card in another PCIe 
slot. Use the HP Performance advisor to update your machine before or after installing your HDX card(s).

Assertions occur when opening a Pro Tools 12 session that uses the Native format of HEAT in Pro Tools 11.x and assigning 
track outputs. (PT-204124)

A session saved from Pro Tools HD 12 on a Native system with HEAT enabled might not display DSP usage for HEAT when opened 
on Pro Tools 11.x on an HDX system. To avoid these assertions and see DSP usage for HEAT on the HDX system, turn HEAT off and 
then back on.

HD Native Systems

Audible pops and clicks when changing buffer sizes (PTSW-125715)

Pops and clicks may occur when changing the Hardware Buffer Size (H/W Buffer Size) in the Playback Engine dialog while monitoring 
live audio through HD Native hardware. Avid recommends not changing the Hardware Buffer Size while monitoring live audio to avoid 
this problem. If you must change the Hardware Buffer Size while monitoring live audio, be sure to lower the monitoring volume to avoid 
any possible damage to your speakers.

Control Surfaces

Stereo panning is not available with Pro Tools | Control and Pro Tools 12.3 using EuControl version 3.3.1. (EUCON-4282)

When using EuControl 3.3.1 there is no stereo pan available on Pro Tools | Control for stereo tracks in Pro Tools. Pan controls appear 
on Pro Tools | Control for mono tracks only. Avid is working to provide an update to EuControl as soon as possible that will address this 
issue.

Selecting a track in Pro Tools auto-scrolls to the first track when going past the bank limits of an Artist series controller. 
(EUCON-3852)

When the Edit Window follows Bank Selection or the Mix Window follows Bank Selection preference is enabled, if you select a track in 
Pro Tools that is beyond banking limits of an Artist control surface, that track auto scrolls to the top of the Edit window or far left of the 
Mix window. In order to avoid this behavior, de-select the corresponding preference, either Edit Window follows Bank Selection or the 
Mix Window follows Bank Selection.



 Pro Tools and Pro Tools | HD Software 12.4 on Windows 7 and Windows 8.1 — 12/20/15 12

Trim Scrub and Trim Shuttle don’t work on clips with fades (PTSW-46911)

If a clip has fades, Trim Scrub and Trim Shuttle don’t work when trying to trim using a control surface. To work around this problem, 
remove any fades on the clip, then execute the Trim Scrub or Trim Shuttle, and then restore the fades.

Used HW output path indication (PTSW-17559)

In Assign Matrix, Insert mode the used HW output path will not have amber background indicating that it's already assigned after 
switching to a different insert on the same track.

Color indication on plug-in controls in Learn mode (PTSW-18480)

When a plug-in is in Learn mode and the track with this plug-in is not focused on the main ICON unit, all automation LEDs in the 
plug-in window will be red if the track is in one of auto write modes. This conflicts with red color indication on the plug-in control, 
which is armed for mapping. The workaround is to set the track with plug-ins to Read automation mode.

Send/Pan mode on D-Command for Sends F–J (PTSW-50046)

In Pro Tools 7.3 and higher, if you save a session on D-Command which is in Send/Pan mode for Sends F-J, the session will open in 
previous versions of Pro Tools with the channel fader controlling that Send level, as if in Flip mode. To avoid this, open the same session 
in Pro Tools 7.4, take the session out of Send/Pan mode, and re-save the session.

SignalTools meter ballistics on control surfaces (PTSW-52799)

SignalTools RMS, VU, BBC, Nordic and DIN meters will display inaccurate decay times when viewed on a control surface. Unaffected 
types are Peak, VENUE, and Peak + RMS, which only reports the Peak meter to the control surface. The attack times of the affected me-
ters are not affected, only the decay times. All meter types display accurately in the plug-in window.

Channel Strip plug-in Expander/Gate meters appear in the Compressor/Limiter meter instead of in the Expander/Gate meter in 
D-Control Dynamics section (Main Unit) (PTSW-150897)

The Avid Channel Strip plug-in uses shared meters for Expander/Gate and Compressor/Limiter processing. Because of this, both Ex-
pander/Gate and Compressor/Limiter metering appear only in the Compressor/Limiter meter in D-Control Dynamics Section (Main 
Unit).

Pro Tools transport must be stopped when recalibrating ICON faders (PTSW-54678)

The transport in Pro Tools must be stopped when recalibrating faders on D-Command and D-Control. If one or more faders need cali-
bration do the following: Stop playback, enter Utility mode, press TEST, press FADER, and press RECAL. After recalibrating faders. 
exit Utility mode.

The Edit and Mix windows do not follow banking on EUCON control surfaces (PTSW-133466)

When the Edit Window Follows Bank Selection and/or the Mix Window Follows Bank Selection preferences are enabled in Pro Tools 
(Setup > Preferences > Mixing), after banking your EUCON controller, neither the Edit nor Mix window scroll to follow. You will have 
to manually change the view of the Edit or Mix windows to see the tracks that correspond to the EUCON controller if they are off screen.

Video

Playback of QuickTime video in Pro Tools may stutter or drop frames

When monitoring QuickTime playback in the Pro Tools Video Window on the computer screen, the video image may stutter or drop 
frames. To improve results with QuickTime playback, try any of the following:

• Disable Continuous Scrolling.

• Close unnecessary UI windows.

• Try using the DNxHD codec.

• A second Pro Tools, Media Composer, or Symphony DX Video Satellite option offers guaranteed performance for Avid video play-
back with a primary HDX or HD Native system.



 Pro Tools and Pro Tools | HD Software 12.4 on Windows 7 and Windows 8.1 — 12/20/15 13

Unsupported QuickTime video formats (PTSW-52140, PTSW-52155, PTSW-52157)

Several video formats supported in QuickTime are not supported in Pro Tools. These include .DivX, .flc, .m4v and .3gp format movies. 
Attempting to import these will generate errors or will fail to import.

QuickTime files that contain multiple CODECs may not import (UME-835)

If the Pro Tools tells you that a file cannot be imported because it may be unsupported, check to see if the file contains more than one 
CODEC. This can be done by opening the file in QuickTime player and examining the file properties. QuickTime files that contain more 
than one CODEC are not officially supported for import into Pro Tools.

Closing the QuickTime window during session playback may result in –9092 errors that stop playback (PTSW-162502)

To avoid this issue, try increasing the number of CPU Cores available for Pro Tools processing and/or raise the H/W Buffer Size in the 
Pro Tools Playback Engine dialog.

“Error reading video in the QuickTime files” when importing some MPEG 1 and 2 video files in Pro Tools (PTSW-178017)

Some MPEG1 and MPEG2 files cannot be opened by Avid applications, including Pro Tools. Transcode these files to one of our pri-
mary CODEC such as DNxHD or AppleProRes for use in Pro Tools to avoid this issue.

MPEG-1 and MPEG-2 video freezes at edit points (79182)

Editing MPEG-1 & MPEG-2 video is not officially supported. If you experience this problem, try switching playback to the Video win-
dow, or convert the movie to a supported format using a 3rd party application. Removing the audio from an MPEG-1 or MPEG-2 movie 
with a 3rd party application may also fix the problem.

3G2 file extension is not supported for video import (PTSW-178015)

Pro Tools 11 provides support for the .3GP file type extension for video import. These are video files often created on mobile phones. 
The second generation of this format uses the file extension of .3G2. Files with the .3G2 file extension will be filtered out as unavailable 
for video import. These .3G2 files may be available for import if their file extension manually changed to .3GP. If the files remain un-
available for import after changing their extension, they will need to be converted to an explicitly supported format such as DNxHD or 
AppleProRes for use in Pro Tools.

Audio and video will not stay in sync when using ASIO4ALL (PTSW-179261)

When ASIO4ALL is selected as the Pro Tools Playback Engine, video may drift out of sync and even drop frames. To avoid this, use 
a supported Avid audio interface.

Video pull factor may become invalid when video hardware is enabled (PTSW-180554)

If a software video pull factor of 0.1% is set while video hardware is disabled, enabling the video hardware may create an illegal pull 
setting. Video hardware only supports 0.1% pull ups at 24pPAL rates, and 0.1% pull downs at 25pPAL rates. If the pull rate is set to 
0.1% at any other rate while video hardware is enabled, manually select an available option from the pull menu, which may be “none.”

Video may not stay in sync when video hardware is attached and Pro Tools is locked to an external clock (PTSW-178722)

If both Pro Tools and an attached video peripheral are each resolved to an external clock, but the clock is not derived from the same 
source, video will not stay in sync. An example of this would be if the video peripheral is locked to black burst, and the audio peripheral 
is locked to an audio clock not derived from the same video black burst, such as SPDIF. In this scenario, setting the video peripheral to 
lock to its own internal clock will allow Pro Tools to compensate for video drift over time.

Video I/O Settings Pane appears inactive after editing video track during play (PTSW-183106)

If you edit video during playback, the I/O Setting pane for the Video track appears inactive during playback, preventing you from open-
ing the track’s Output Setting tab. To access I/O settings for the track, stop playback. 
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Third-Party Video Peripherals
The following issues may occur with third-party video hardware. Please contact your hardware vendor for support.

 In some cases, video will not stay in sync over time if the video peripheral is not, or cannot, lock to video reference. If you experience 
this, a workaround is to set the Pro Tools clock to internal. This will cause the video peripheral to slew overtime and stay in sync with 
Pro Tools. (THPV-2)

 With some peripherals video playback will be one frame out of sync with Pro Tools audio. To compensate for this, choose Setup > 

Video Sync Offset and enter a 1 frame offset. (THPV-9)

 Some video peripherals will lose AV Sync when playback is attempted from a 9-pin controller when linked with other Pro Tools or 
Media Composer Satellites. To avoid this issue, attach the 9-pin controller to a Pro Tools Satellite that does not have a third-party video 
peripheral attached. (THPV-11)

 With some video peripherals, the video output will be scrambled when video is not loaded in Pro Tools, or when the video peripheral 
is disabled. (THPV-32)

Synchronization and Machine Control

Recording with serial timecode (PTSW-63013, PTSW-60432)

Occasionally, it is possible for the Tascam DA-98 servo lock bit behavior to cause Pro Tools to think the DA-98 is servo locked before 
it actually is. This could cause a synchronization offset when Pro Tools locked to serial timecode generated from a DA-98. Pro Tools 
will now handle these cases, but if you experience this problem, try increasing the amount of frames to 10 in the “Delay before locking 
to Timecode” preference. 

The “Machine Cues Intelligently” preference should not be used with non-linear decks (46200)

Pro Tools overshoots and posts an “Error Cueing Machine” dialog if the Machine Cues Intelligently preference is checked when using 
non-linear playback devices.

Video Satellite

Pro Tools and Media Composer Video Satellite Quit Unexpectedly when Disconnecting an Additional Pro Tools System During 
Playback (PTSW-23142)

When multiple Pro Tools systems are connected via Satellite Link in conjunction with a Video Satellite, always stop playback before 
disconnecting any of the systems. 

“Pro Tools Cannot Currently Play” Error (Item # UDevC00116083)

In a Video Satellite configuration, when the system is sitting idle, Media Composer may post the dialog, “Pro Tools cannot currently 
play, is online with Machine Control, or is in Transport = Remote Mode. Please resolve the issue with the Pro Tools system and try 
again.” To avoid this problem, link the Video Satellite from the Pro Tools Administrator system rather than from Media Composer.

Media Composer Video Satellite cannot be enabled when Pro Tools is co-installed on the same computer (UME-956)

When Media Composer and Pro Tools are co-installed on the same computer, that system cannot be used as a Video Satellite. To use 
the computer as a Video Satellite, uninstall Pro Tools and re-install Media Composer. 

23.976 or 24 fps Sequence Start Time Ending In Digits Other than “:00” Causes Time Code Offset 

Media Composer uses NTSC or PAL time code when setting the sequence start time regardless of the format selected by the user for 
display. When you are working on a video satellite project at 23.976 or 24 fps, a Media Composer sequence with a start time that ends 
in a value other than :00 causes an offset between Pro Tools and Media Composer at the session start. For example, the start time 
45:02:10:15 (ending in :15) would cause an offset, but the start time 45:02:10:00 (ending in :00) would not.

As a workaround, always set your Media Composer sequence start time to a time code value ending in 00.
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Cueing from Media Composer in a 720p Project Causes 1-Frame Offset (Item # 98460)

In 720p projects, Media Composer counts at 50 or 60 (59.94) progressive fps—depending on the project type—while Pro Tools counts 
at 25 or 29.97 frames per second. When you cue a sequence from the video satellite in a 720p project, the Pro Tools edit cursor can be 
offset by as much as one frame. 

As a workaround, cue and play back from Pro Tools when working with a 720p project in a video satellite system. This ensures that the 
two applications are always in sync. It is not possible to cue to odd 50 or 60 frame boundaries (for example, frame 47) from Pro Tools.

Audio and video may drift out of sync In Satellite Mode in certain conditions (Items # UDevC00090064, UDevC00090078, 
UDevC00088666, UDevC00089437, UDevC00087542)

When operating in Satellite mode, audio and video output from Media Composer may drift out of sync by as much as one frame in any 
of the following conditions:

• When viewing video full screen in 1394 mode. This is due to the difference between the monitor's refresh rate and the video reference 
rate.

• When the Edit Play Rate of the video differs from the frame rate of the video reference signal. (For example, this occurs with a 24p 
NTSC project with 23.976 Edit Play Rate and NTSC reference signal.)

• When looping a selection that is not aligned to video frame boundaries in Pro Tools. As a workaround, make your selection in 
Pro Tools using Grid mode with the Grid value set to 1-frame increments—especially when it is necessary to loop several times with-
out stopping.

General Localization 

Relinking using MacDrive Version 6 to open sessions from other platform (PTSW-63606)

MacDrive version 6 strips the extensions off of files in “Normal Use” mode - you need to use “Backup/File Transfer” mode to avoid 
having the extensions stripped off. However, “Backup/File Transfer” doesn't work well with multibyte characters, as “International 
Use” does. “International Use” also strips the extensions, so you either have to not use multibyte characters, or have the trouble with 
stripping extensions. These used to be separate options in MacDrive 5, but in 6 you can't get one without the other. To get around the 
stripping extensions, you can do a Relink by ID only, and have it search through all the files to match them up - this is the only work-
around.

AAF/OMF sequences with non-English characters import with garbled clip names or won't relink (PTSW-33569, PTSW-99570, 
PTSW-33826) 

If an AAF/OMF sequence containing files or clip names with non-English characters is exported from a Mac-based Pro Tools 7.3.1 sys-
tem (or lower), it may not import correctly into Avid Media Composer, or Pro Tools 7.4 and higher systems on Windows or Mac. Con-
versely, AAF/OMF sequences with non-English characters exported from any Pro Tools 7.4 or higher system (or higher) may not im-
port correctly into a Mac-based Pro Tools 7.3.1 (or lower) system. To relink the files, select “Manually Find and Relink,” then deselect 
all options except “Find by file ID.” Clip names may appear garbled.

Inconsistent MIDI performance on Dutch OS with English Pro Tools (59608)

When running the English version of Pro Tools on Dutch OS, MIDI output can slow down with extended use.
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Known Issues with Audio Interfaces
Avid DigiTest firmware updates appear to freeze when DigiTest is not the front-most application (PTSW-138994)

When clicking outside the Avid DigiTest window, the Graphical User Interface (GUI) may appear to freeze. However, the firmware up-
date will complete successfully. If you encounter this issue, please wait for the firmware upgrade to finish. You will know that the firm-
ware update completed successfully when the GUI becomes responsive again.

When switching audio interfaces, some devices may fail to load proper drivers with the Found New Hardware wizard 
(PTSW-28118)

When switching audio interfaces, the Found New Hardware Wizard will sometimes properly identify the device, but then fail to install 
the needed drivers. If this happens, with the new device connected, go to Add or Remove Programs in the Windows Control Panel, 
choose the audio interface, select Change, and run a “Repair” install. The driver installation should complete with the Found New Hard-
ware Wizard.

Changing sample rates during a session can cause session to play at a faster or slower speed (56697)

Changing Sample Rate during a session from the Control Panel for your audio interface can cause the audio to playback at the incorrect 
speed. Consequently, the data could be unrecoverable afterwards. Before creating a session, set the Sample Rate in the Control Panel 
for your audio interface and do not make changes thereafter.

HD OMNI

Noise in the output signal from HD OMNI with digital input (PTSW-1614)

If HD OMNI is connected to a digital source with a mismatched clock and Sample Rate Conversion (SRC) is not enabled, you will hear 
noise (including loud “pops”) in the output signal. To correct this problem, either enable SRC or ensure that the clock of the digital 
source and HD OMNI are matched correctly.

HD OMNI front panel Setup menus are unresponsive after Pro Tools quits unexpectedly (PTSW-125692)

HD OMNI will not automatically recover “stand-alone” mode if Pro Tools quits unexpectedly (or if you disconnect the DigiLink cable 
from HD OMNI while Pro Tools is running). As a result, some of the SETUP functions accessible from the front panel will be unavail-
able. Power cycle HD OMNI to recover stand-alone mode.

Graphic redraw problems in the Hardware Setup dialog (PTSW-122690, PTSW-1346, and PTSW-1235)

When changing the Hardware Setup configuration for HD OMNI, it is possible to encounter graphics redraw problems in some cases. 
To force a graphics redraw of the Hardware Setup dialog, close and reopen the Hardware Setup dialog.

No sound on output after Hardware reset (PTSW-126575)

After resetting the HD OMNI interface to the default factory settings using the front panel controls, the HD OMNI interface stops emit-
ting sound in sessions where the outputs are not assigned to the Monitor output path. To correct this problem, press the ALT monitor 
button to switch to the ALT Monitor path, and then press it again to switch back to the Main Monitor path. 

Loss of monitor path with launching Pro Tools with HD OMNI off or disconnected (PTSW-127313)

When launching Pro Tools and opening I/O Setup after powering off HD OMNI or disconnecting it from the system, the inactive Mon-
itor path is not present in Output tab. You may need to restore the default I/O Settings and remap the corresponding Output Busses.

Output paths are not automatically created in the Output page of the I/O Setup after disabling the corresponding monitor path 
in the Monitor page of the Hardware Setup, and re-assigning the outputs from “None” to physical outputs in the Main page of 
the Hardware Setup (PTSW-127559)

After disabling the Monitor path in the Monitor page of the Hardware Setup and re-assigning the corresponding Outputs from “None” 
to physical outputs (such as “A 1-2”) in the Main Page of the Hardware Setup, these Output paths are not automatically created in the 
Output Page of the I/O Setup. You will have to manually create the appropriate Output paths in the I/O Setup (or click Default).
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Changing monitor path output assignments in the Hardware Setup does not update the output paths in the Output page of the 
I/O Setup (PTSW-127563)

When changing Monitor path Output assignments in the Monitor page of the Hardware Setup (such as setting the Monitor path Format 
to None or assigning the Monitor to different physical outputs), the Output paths in the Output page of the I/O Setup do not reflect the 
corresponding changes. You will have to manually create the appropriate Output paths in the I/O Setup (or click Default).

When creating new sessions, using the I/O Settings selector can result in unexpected output assignments if HD OMNI has an 
assigned Monitor path (PTSW-123896)

If HD OMNI has an assigned Monitor path, Output paths created by the selected I/O Settings option in the New Session dialog may be 
offset by the channel width of the Monitor path. If this happens, you will have to manually create the appropriate Output paths in the 
I/O Setup (or click Default).

I/O Setup Bus page erroneously adds Monitor paths (PTSW-127739)

With both MAIN and ALT Monitor paths declared, toggling one of the CR Monitor paths from the current format to “None” and then 
back to the starting Monitor format from within the Hardware Setup Monitor page, causes the Bus page in I/O Setup to erroneously add 
an extra Monitor path with the abbreviation with “(1).” This can happen numerous time and each new Monitor abbreviation increments 
accordingly.

Avid Audio Interfaces with ASIO Third Party Client Software

When adjusting the Hardware Buffer Size in a third-party audio application (such as Reason), the Avid Hardware ASIO driver 
may quit unexpectedly (PTSW-162469, PTSW-154719)

It is possible to select an unsupported hardware buffer size for some Avid audio interfaces when using third-party ASIO client software 
(such as Reason or Cubase). To avoid this issue, use the Avid hardware driver control panel to change the hardware buffer size.

003 Series Interfaces

Windows Standby Mode and the 003 interfaces (47054)

Always disconnect 003 interfaces before putting Windows into Standby mode. 

Importing .PIM Files on an 003 System with a C|24 (PTSW-46401)

When importing a custom map .PIM file created on a 003 to another 003 system with a C|24, 003 displays “<No Track>” on the scribble 
strips instead of staying in Plug-in Edit mode with a restored newly imported Plug-in Map. You will need to switch to another mode on 
003 and then re-enter Plug-in Edit mode to correct this.

Mbox Pro

Pro Tools appears unresponsive with Mbox® Pro (PTSW-184498)

If Pro Tools appears to be unresponsive with Mbox Pro, check to ensure that the Mbox Pro is synchronized to the proper clock source 
(Setup > Hardware) and that the clock source and your Pro Tools session have matching sample rates. If Mbox Pro encounters a problem 
with the clock source (such as mismatched sample rates between the clock source and the session), Pro Tools may become unrespon-
sive.

Mbox 2 Pro

The Mbox 2 Pro driver version 11 does not work with Pro Tools 10.x (PTSW-182163)

The Mbox 2 Pro driver version 11.0.0 will not work with Pro Tools 10 or lower. Use Mbox 2 Pro driver version 9.0.2 with Pro Tools 
10 or lower.

External clock not supported at higher sample rates with Mbox 2 Pro (PTSW-59087, PTSW-59095, PTSW-59097, PTSW-58879)

Although Mbox 2 Pro supports sample rates of up to 96 kHz, its external clock sources (S/PDIF and Word Clock) are only supported 
in 44.1 and 48 kHz sample rate sessions.
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Transport disabled after changing sample rate of external sync source (PTSW-58879)

If the Pro Tools Clock Source is set to S/PDIF or Word Clock, and the sample rate of your external source changes, sync will be lost 
and you may not be able to play back when sync resumes due to –9092 errors. This is most likely to appear if the sample rate of your 
external source changes while the Pro Tools transport is moving. 

To avoid this condition, make sure your external source is always set to the same sample rate as Mbox 2 Pro, especially during playback.

To correct this condition should it occur, do the following:

1 In Pro Tools, choose Setup > Hardware and set the Clock Source to Internal

2 Make sure your external sync source is properly connected and at the same sample rate as Mbox 2 Pro.

3 In Pro Tools, choose Setup > Hardware and set the Clock Source back to the desired source (S/PDIF, Word Clock, or Internal).

Some machines may encounter “Audio Play Startup Deadline was Missed” errors at HW Buffer size 64 or if “Minimize Additional 
I/O Latency” is enabled (PTSW-28238)

On some machines, and with Mbox 2 Pro, enabling “Ignore Errors During Playback/Record” and selecting “Minimize Additional I/O 
Latency” in the Playback Engine dialog, or running at a HW Buffer size of 64 samples may cause you to encounter “Audio Play Startup 
Deadline was Missed” errors when starting the transport. This may be compounded if the Mbox 2 Pro is synced to an external clock. If 
you encounter this, set your clock source to Internal and, if needed, deselect “Minimize Additional I/O Latency” and set the HW Buffer 
size to 128 or higher. 

Mbox 2

MBox 2 can have lower track counts on Windows 7 on the HP 8600

Depending on your CPU, you may need to disable your computer’s network cards in order to achieve the maximum possible track 
counts.

Audio pop through Mbox 2 outputs when enabling/disabling AC-3 Mode (63293)

In the Mbox 2 Control Panel, checking or unchecking the option for AC-3 produces an audio pop through the analog output. 

Mbox 2 does not support sample rates of 49 kHz or Above (63141)

Mbox 2 does not support sample rates of 49 kHz or above due to the bandwidth limitations of USB 1.1 and the USB Controller. This 
is only an issue when syncing to an external S/PDIF clock that is pulled up 2% or more above a nominal 48 kHz sample rate.

ASIO and WASAPI

Pops and clicks can occur when using third-party ASIO audio interfaces with Pro Tools (PTSW-132084)

Note that audible pops and clicks can occur when using some third-party audio interfaces even if Error Suppression is disabled. Try in-
creasing the Hardware Buffer size for the device to avoid this problem.

Pro Tools cannot locate installed ASIO hardware on launch (PTSW-132125)

There are known issues with some third-party ASIO devices not being recognized by Pro Tools 10.x. For a list of third-party hardware 
compatibility issues, please visit www.avid.com/compatibility.

When using Pro Tools or Pro Tools HD with WASAPI or ASIO, Pro Tools cannot create or open sessions that have a different 
sample rate than Windows default audio interface. (PT-201662)

When using Pro Tools or Pro Tools HD software with WASAPI, Pro Tools cannot create or open sessions that have a different sample 
rate than Windows default audio interface. To avoid this issue, exit Pro Tools, disable the audio interface in the Windows Control Panel, 
and then launch Pro Tools to create or open a session using the desired sample rate.

Enabling the Avid Video Engine with WASAPI set as the Pro Tools Playback Engine results in no video playback. (PT-202291)

Loss of video playback can occur if WASAPI is selected as the Playback Engine when the Avid Video Engine is enabled. This config-
uration is unsupported at this time. 
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Error Messages
Error –6031 during playback (32637)

If you encounter a –6031 error while playing back a session with dense MIDI or automation, stop playback, save and close the session, 
quit and re-launch Pro Tools, then re-open the session before resuming playback.

DAE Error –9132

If a –9132 error occurs during Bounce To Disk (even with the highest Hardware Buffer setting selected), bus the desired tracks to the 
appropriate number and format (mono or stereo) of audio tracks, then record them to disk instead of bouncing.

Error –5000 (Unknown Error) when launching Pro Tools (36130)

On a system with multiple partitions, if different InterLok PACE versions are installed on different partitions, Pro Tools will report an 
“Unknown –5000 error” on launch. To avoid this problem, install the same PACE components on all partitions on your system.

Error –6042

If you repeatedly encounter –6042 errors, open the System Usage window and check the PCI gauge. If the gauge is peaked, you will 
need to reset the PCI bus. To reset the PCI bus, make all tracks inactive and start playback. If you still encounter a –6042 error, quit and 
relaunch Pro Tools, open the Playback engine dialog, and change the Number of Voices to a setting that uses fewer per DSP. 

Error –6074 when toggling all plug-ins between Active and Inactive mode during playback (55049)

In large sessions, deactivating and reactivating all the plug-ins simultaneously can cause Pro Tools to post the following error: “The en-
gine DSP ran into the TDM2 deadband. Too many I/Os to the TDM2 chip (–6074).” To resolve the problem, activate and deactivate 
plug-ins in smaller groups.

Error –9073 when recording to a FireWire drive and the 2 GB file limit is reached (42611)

When the 2 GB file limit is reached during recording to FireWire drives, a –9073 error is posted instead of the expected “Recording has 
been terminated because a disk is full” dialog. This error is benign, and does not signal any data loss or problem with the hard drive.

Error –9073 other than when recording to a FireWire drive and the 2 GB file limit is reached

If you encounter a –9073 error, refer to the Answerbase for possible causes and solutions (www.avid.com/us/support).

Error –9128

In sessions with high sample rates (96 kHz or higher), you may need to set the Hardware Buffer Size to 512 or more to avoid –9128 er-
rors during playback with Native plug-ins or dense automation.

Error –9155

In sessions with high sample rates of 96 kHz or more, you may need to set the Hardware Buffer Size to 512 or more to avoid –9155 er-
rors during playback with dense automation.

Error –9735

When Pro Tools reaches the end of its time limit in the Timeline, or if Pro Tools has been in continuous play for longer than the maxi-
mum time limit, you will encounter a DAE error –9735. The maximum time limit for Pro Tools depends on the session sample rate. For 
more information, see the Pro Tools Reference Guide.

Errata
The Pro Tools Reference Guide, versions 12.3 and 12.4, erroneously excludes Clip Transparency View (View > Clip > Transparency). 
When enabled, this option shows transparent clip overlays when moving clips on the timeline. When this option is disabled, clips are 
not transparent when moving them on the timeline (which is legacy Pro Tools behavior).
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